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1. Introduction 
FNet is a program, which can be used to control a suite of up to six LAMDA MINIFOR 
fermenters to a PC. It runs under Windows 95, 98, NT4, 2000 and XP. Windows NT4/2000 
are recommended. 
Please read also the e_readme.txt file, which contains the latest information about the 
program.  
 

2. Program installation 
Start the set-up program on the installation CD and follow the instructions. It is strongly 
recommended to read the file readme.txt first. This file contains the latest information about 
the program. 
 

3. Operating instructions 

3.1. Fermenter window 
There is a separate window (figure 1) for each of the 6 fermenters. In these windows 
the fermenter parameters (e.g. setpoints) can be read or changed and the 
configuration modified (e.g. alarms values). 
 

 
Figure1: Fermenter Window 
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There is a 3 level management system for accessing the program functions: 
Level 1: all functions which are often accessed (like set point, profiles start...) have a direct 
access with button on the window. 
Level 2: functions, which are used only occasionally (like calibration), can be accessed in the 
menu. 
Level 3: the configuration of the installation (like the integrator address) can be accessed 
only with a password 
 

3.2. Menu 
File 

Printer configuration:   printer choice and its parameters for the application 
Print:     prints out the whole window  

Data 
Prepare saving  choice of the channels to save 
Saving start/stop  starts or stops the saving of channel values in a file  

Options 
Configure a profile  to enter a profile for the setpoints 
Start/stop a profile  start or stop the profile 
Alarms configuration configuration of the alarms for the measured values 
Calibration   to calibrate the integrators and the pumps 
Channel choice  channel choice for the trend 
Ruler   activate or delete the cursor on the trend 
Reduce time scale  to see less details      
Increase time scale to see more details 
Auto. time interval the  curves are automatically shifted to the left  

Configuration    
Enter   to personalise the software 

The most used functions are also accessible with a quick button.  
 

3.3. Local and remote mode 
When the fermenter is switched on, it started in the local mode. The user can change the 
setpoints and calibrate the probes on the fermenter keyboard. He cannot change the setpoint 
value from the computer. 
To activate the remote mode, click on the Rem button. You can then change the setpoints 
from the computer keyboard or work with profiles. 
 

3.4. Fermenter status 
The fermenter status is indicated with green LEDs.  
Run:  main control of the fermenter is activated with button R on the 

fermenter keyboard. 
Air flow control:   the program controls the air flow independently of the pO2 setpoint. 
pO2 control:   the dissolved oxygen concentration is controlled with the airflow rate. 
The program calculates the flow rate to keep the pO2 at the set point value. 
Acid:     addition of acid to maintain the pH at the desired value 
Base:     addition of base to maintain the pH at the desired value 
The main control of the fermenter can be started with button R on the fermenter or button 

 in the fermenter window. 
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3.5. Change a set point 
Double click on the setpoint field (figure 2). A new field will appear in which the new value 
can be entered.  
 

 
Figure 2: Change a setpoint value 

 
 
Close this field with the enter key. If the entered value is out of the channel range, it will not 
be accepted. The setpoint can also be with the scrolling arrows. 
 

3.6. Trends 

Description 
Up to ten channels can be shown (measured value or setpoint) as trends. The legend shows 
the channel: name, its unit and its value at the time indicated on the right. 
 

 
Figure 3: Trend 
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Channel choice 

Click on the  button. A new window will appear. 
 

 
Figure 4: Trend configuration 
 
 

Select a channel from the list, copy it into a field in the channel column with the ’>’ button. 
Choose an axis (Y1 and Y2 are on the left, Y3 and Y4 are on the right). Select a colour from 
the colour list. To delete a channel click on the ‘<’ button then close the window with the OK 
button. 
 

Automatic time interval 

In this mode the new values are automatically added to the curves. The  button is down. 
The time on the top right is the time of the last added point. The speed of the curve 
displacement depends on the time interval. To change this time double click on the time axis, 
a new window appears (figure 5). It contains a time and a date, which corresponds to the 
time at the left of the trend. 
 
 



 7

 
Figure 5: Time interval for the trends 

It is important to take care when formatting the fields. The minutes, hours, days, months and 
year must have 2 characters (e.g. 2 :03  2/01 = wrong, 02:03 02/03/01 = right). Clicking on 
the grid check box can show a grid. 

It is also possible to change the time scale with the buttons  and . 
The time interval is limited to 3 days in this mode. 
 

Fixed time interval 
In this mode the curves are fixed. It is then possible to choose the time at the left and the 
right of the trend. The rules for formatting the values are the same as for automatic time 
interval. 

It is also possible to change the time scale with the buttons  and . 
The time interval can be up to 60 days. 
 

The ruler 

Click on the  button. If the trend was in automatic time interval mode it will change to fixed 
time interval mode so that the curves become fixed. A black cursor appears at the left of the 
trend. Clicking with the mouse on this displaces the cursor. The legend shows the value of 
the channels and the time corresponding at the right. When finished with this cursor, it can 
be deleted by clicking again on the button or pass into automatic time interval modus by 

clicking on the  button. 
 

Y Axis 
To change the scale of the Y axis double click on it. A new window appears which allows the 
maximum and values for the axis to be entered. The minimum value must be smaller than 
the maximal value. Clicking on the grid check box shows a grid. 
 

3.7. Alarms 

An alarm interval can be set for each value measured. Click on the  button and a new 
window will be shown (figure 6). Enter the new alarm values and close the window with the 
OK button.  
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Figure 6: Alarm configuration. 
 

When an alarm is active a red field appears in the fermenter window. 
 

3.8. Saving data  
With this function the measured values and setpoints can be saved in a text file. This file can 
be opened with most available software e.g. spreadsheets or word processing programs. 
 

Preparations for saving data 
Choose command Prepare saving in the Data menu. A new window appears (figure 7).  
 
 

 
Figure 7: Saving data in a text file 
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The filename, channels to be saved and the saving period can be chosen. To select more 
channels, click on the channel name and hold the Ctrl Key down (multiple choice). Selecting 
the time format: 
relative: the time in the file begins with 0 
absolute: the time in the file has the date and the time for every line 
period: time between two lines in the table 
decimal separator: depends on the software to be used to read the file. 
 

Start/stop data saving. 
The data are saved only if the command Start/stop saving in the Data menu is started. 
 

3.9. Profile 
Using this function a profile for a setpoint can be defined. The profile is constructed from one 
or more segments which are connected together. 

Click on the  button. The profile definition window appears (figure 8).  
 
 

 
Figure 8: Setpoint profile definition  
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Choose a channel and then enter the associated profile in the table. The first value is the 
start value and the second value is the end value. The time represents the time taken to pass 
from the first to the second value. The program calculates the values between the two points 
and sends them as setpoints to the fermenter. After you have entered the profiles, click on 
the OK button. The program checks the values and stores them in its internal memory. The 
profiles will only start on the next step. 
 
A table can be saved in a file. Click on the ‘save’ button, enter a filename and close the 
window with OK. 
 
 

 
Figure 9: Start or stop a profile 

 
 

To start a profile click on the  button, the ‘Start or stop a profile’ window appears. Click on 

the button  to start the associated profile. When restarting a profile that has been stopped, 
it starts where it was stopped. To start the profile again at the beginning of the table, click 

then on the reset button . 
 
The program can only send the setpoint values to the fermenter if it is in remote modus. 
Please check if the Rem button is down. 
 

3.10. Integrator 
 
Connected to the pump, the integrator will allow you to visualise how much liquid has been 
pumped by the pump in function of time. This information was not available upto now.  
 
The heart of the pump is a stepping motor controlled by a generator of electrical impulses. 
After each impulsion motor turns by one step. This movement is transmited to the rotor, 
which by compression of the tubing displaces a small amount of liquid in  the flow direction. 
The integrator registers impulses received and transforms them into an electrical signal. This 
signal is treated and displayed by fnet on your PC. 
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When the pump is used for regulation of a reaction condition such as pH, temperature, 
antifoam control or another parameter, it is important to know how much of the solution (acid 
or base for exemple) has been added to maintain the pH constant. This complementary data 
will inform you about the cinetics of the bioprocess, its completion or even  disturbances. 
 
 
3.10.1. Address 
For communication with the Integrator, the program must know its address. Only the program 
can give a new address to this instrument (the program ‘capture’ the integrator). To do it, 
please choose the command Integrator in the menu ‘Configuration’ (the password is fnet). 
 
 

 
Figure 10. Capture of an integrator 

 
 
Disconnect all the other integrators on the line. Choose the address you want to give to the 
integrator. This address has to be unique. Close then the window with the OK button. 
For instruments addressing you can also see below (4. Connecting the PC to the fermenter). 
 
 
3.10.2. Start/stop of the integration 

At start the program stops all the connected integrators. Click on the button  to start the 

measurement. To reset the instrument, click on the reset button . 
 
 
3.10.3. Calibration 
To know the real amount value of liquid corresponding to a signal and a tubing used, you 
have to calibrate it. Click on the command ‘Calibration in the menu Options and then click to 
Amount1 or Amount2. The calibration window will appear (Figure 11). 
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Figure 11. Calibration window 
 

Press then the start button . Start the pump and collect the liquid in a flask. When you 
have collected enough liquid to measure it you can stop the pump and then you can press 

the button  to stop the integration. You can then enter the amount of liquid (weight or 
volume) in the field Amount at stop and the unit. Close then the window with OK. 
 
The amount value can be shown on the curves and stored in a file like the other fermenter 
measurement. 
 

3.11. Pump 
The program can also control one pump for one fermenter. This pump can be used for 
example for a feed. The address of the pump is entered directly on the pump (see 4. 
Connecting the PC for address values). 
The fermenter setpoint is entered like fermenter setpoint. There is also a possibility to 
program a profile like for the other fermenter setpoints.  
 
3.11.1. Calibration 
On the pump the rotation speed is entered in digit. To enter the real flow rate you have to 
calibrate it. (The flow rate depends naturally on the size of tubing). Click on the command 
‘Calibration’ in the menu Options and then click to Pump. The calibration window will appear 
(Figure 10). 
 

 
Figure 11. Calibration window 
 

Enter the pump speed in digit and the corresponding flow rate you have measured. You can 
also enter the unit of the flow rate 
Close then the window with OK. 
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When you enter a new setpoint value, the program will convert the real value in the 
corresponding digit value and send it to the pump. The profile values in the profile table will 
also be converted into a digit value before sending it to the pump.   
 
 

3.12. Program configuration 
To change the default configuration of the program choose the command ‘Enter’ in the 
‘Configuration’ menu. Enter the password ‘fnet’ in the window, which appears. Some new 
commands appear in the menu. The number of the fermenter appears in the title window. 
The other command ‘device terminal’ is a diagnostic tool for use by service technicians. 
When the configuration is finished, use the Exit command to close the Configuration menu. 
 

4. Connecting the PC to the fermenter 
The PC must have a free serial COM1 port. The slave address on the fermenter and 
integrator are listed below: 
 
Fermenter 1 = address 1 
 Integrator 1 = address 7 
 Integrator 2 = address 8 
 Pump = address 9 
 
Fermenter 2 = address 2 
 Integrator 1 = address 10 
 Integrator 2 = address 11 
 Pump = address 12 
 
Fermenter 3 = address 3 
 Integrator 1 = address 13 
 Integrator 2 = address 14 
 Pump = address 15 
 
Fermenter 4 = address 4 
 Integrator 1 = address 16 
 Integrator 2 = address 17 
 Pump = address 18 
 
Fermenter 5 = address 5 
 Integrator 1 = address 19 
 Integrator 2 = address 20 
 Pump = address 21 
 
Fermenter 6 = address 6 
 Integrator 1 = address 22 
 Integrator 2 = address 23 
 Pump = address 24 
 
 
* Note: For optimal function one 120 ohm resistor has to be connected between both RS485 
+/- signal lignes 
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Figure 13: Connection between PC and fermenter 
 

5. Troubleshooting 
5.1. No communication between the ferments and the program. 
Please check the address on the fermenter and the cable connections 
 
5.2. The surface on the curve window stays empty but some channels are visualised. 
Please close the program and delete all the files with extension .DB (like 
MiniFor(1)_ActualAirFlow.DB, MiniFor(1)_ActualpH.DB, MiniFor(1)_ActualpO2.DB, 
MiniFor(1)_ActualTemp.DB ) in the installation directory. If the problem still remain then 
delete also the file Fnet.ini. 
 

6. Extensions and new features. 
If you need more customised software please contact Sysmatec or Lambda. We will extend 
the software for your needs. 
 

7. Import data in another program, Example with EXCEL 
The most program on the market (like Quattro, Excel...) can read the data stored in the text 
file. To open one file with Excel (Microsoft) choose ‘Open’ in the ‘File’ menu. It appears a 
window, which allow you to select the desired file (you can use the text file filter in the list to 
allow you to find your file quicker). Choose your file and close the window with OK. It appears 
a new window. Close this window with End (all the options in this file are the default options 
in Excel). 
If you chose the absolute time in the text file you can then choose the formatting option in 
Excel (the format in the text correspond to the OLE automation format). Select the time 
column with the right mouse. Choose a format in the properties entry. 
If the chosen format don’t appear in the column, it is probably because the decimal separator 
you have chosen in Net is not the same for your computer. Try the other separator or change 
it in your computer  (land options). 
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